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Assessment
Where are you on the technology /
knowledge management spectrum?

“Low tech”

“High tech”

“Mixed bag”

Where are you on the technology-knowledgment spectrum?

“Low tech” suggests you have basic, manual systems such as a filing system,
calendar,  tickler method, rolodex, and matter listing.

“High tech” suggests you have a matter management system, document
assembly software, intranet, extranet, electronic billing, and other virtual
systems.

“Mixed bag” means you have some manual and some technological solutions
applied to managing your legal function.
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Basic systems needed to effectively manage
the corporate legal function

Systems
Calendar, docket, or tickler
File or matter list
Contact list

Solutions
Network server
Internet access
Word processing software
Integrated email and calendar software
Database, spreadsheet, presentation software
Adobe Acrobat not just Adobe Reader
Scanner even better networked, high speed copier/scanner

Pamplin’s legal department provides services to several entities and each
of these entities is involved in a different area of law .

To track down pending matters and administer contracts, we still use a
manual calendar to follow-up deadlines. The calendar is reviewed at least
once every week and a list of pending matters is sent via email to the
specific business unit for action.

We use basic technology tools like telephones, fax, personal computers,
printers, a central network server, scanners, internet connection, word
processing, electronic mail, spreadsheet, presentation, adobe, and a small
intranet.

The software we use includes Microsoft Office Word, Microsoft Office
Outlook, Microsoft Office Excel, Microsoft Office Document Scanning,
Microsoft Internet Explorer, Microsoft Power Point, Adobe Acrobat,
Adobe Reader, Adobe Designer, and Windows Media Player.

Communications between the legal department and management is
conducted mostly via telephone and email. The intranet is used to provide
general information to employees. The only legal document posted in the
intranet is the confidentiality agreement, that must be signed by
employees with access to sensitive information. In case there is a need to
grant access to other legal documents, we place the specific document in a
designated drive that can be shared with that particular employee.
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Strategies for implementing technology
solutions

Assess and prioritize your needs (plan for the future)
Consider your resources and maximize them
Establish effective manual systems before your automate
or digitize a flawed system
Use corporate standard software if possible
Keep informed of evolving solutions
Use advanced features of off the shelf software
User your file system to manage knowledge not just for
(lost) archives
Involve your frontline in creating solutions
Be a part of the IT/office equipment specifications team

ACC’s 2006 Annual Meeting: The Road to Effective Leadership October 23-25, Manchester Grand Hyatt

Off the shelf solutions
Use your network drive(s)

Establish a secure “Legal” subdirectory
Alternatively use stand-alone drives

Effectively use office equipment
High-speed, networked copier, scanner, printer
Multi-function fax, scanner, printer, copier

Use standard, integrated office suite applications
Use databases like Microsoft Access or FileMaker Pro
Scan documents in a useable format such as Adobe’s
portable document format (PDF) and attach to database
Consider using free internet services that offer group
calendaring
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Going “High Tech”
Software specifically designed for legal applications

Matter/case management software
Document assembly/management
Corporate entity software/registered agent

Use of an intranet and/or extranets (into the Ether . . .)

Internet enabled platforms; hosted solutions
The biggest challenge: finding solutions that work
for a small law department at an affordable cost
Another challenge: finding a solution that is
designed for corporate legal departments in the first
place
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Intranets
If you have a network, you can have an intranet
site
Determine the use and audience

Departmental use only (home page)
Organizational use

Content
Department use: communication, common work
space, forms, etc. (front end interface)
Organizational use: department info/contacts, forms,
intellectual property information, compliance,
policies/procedures, training, links, FAQs (virtual,
always available extension of your function)

Intranets can be used for a wide variety of uses.  Some Legal Departments
will choose to use an intranet to communicate within the Legal Department
by using an intranet as a collaboration tool or “front end interface.”  Other
departments use intranets as a virtual extension of the Legal Department.
You can provide links to company information (corporate information,
product information, policies, procedures, compliance, etc.).  An intranet
can also be useful for training.
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Intranet Case Study
Example site map of a Legal Department intranet

Welcome page with department mission statement

Main page

Frequently Asked Questions
ESPP and others

Compliance
Code of Business Conduct; other policies

Policies/Procedures
Code of Business Conduct; Insider Trading; Etc.

Intellectual Property
List of active trademarks; link to IP page

Stock
Inisder Trading Policy; ESPP; Plan documents;

Investor info.; Compliance; Notice of Exercise; etc.

Forms
Commonly used forms or request forms

Links
ABA Daily Life Issues: www.abalawinfo.org

Other topical sites

Points of Contact
Who to contact for what and their backups

Presentations
Trademark; Risk Management; Staffing; ESPP; and

others

Contacts
Legal Department staff, titles, contact info.
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Extranets
Litigation work spaces, especially for
discovery, and especially for complex
litigation

Due diligence.  The virtual data room

Secure space for online communication,
collaboration, training, and dissemination

Board of directors work spaces

Extranets are secure websites accessible over the internet.
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Other internet applications

Research

Matter management

Virtual litigation and due diligence

Board work spaces

The internet has become an essential research tool for lawyers.  This is especially true for in-
house lawyers with limited budgets.  Both WESTLAW and LEXIS/NEXIS offer subscription
packages that can be tailored to individual, organizational needs.
There are several free research services available as well.  Look at state bar association,
government agencies, and law school sponsored websites for useful sources of legal
information.
Consider publishing (sharing) your list of favorite legal research and information websites
within your department and with other colleagues.
Here are few useful legal search engines and websites you may want to explore.
FindLaw (www.find.law.com).  This is a free online legal research directory.  There is a
special section devoted to corporate counsel and registered users can customize their own page
based on legal interests, industry, etc.
Catalaw (www.catalaw.com).  A catalog and directory of legal web pages.
Hieros Gamos (www.hg.org).  Worldwide legal directory.
Katsuey’s Legal Gateway (www.katsuey.com).  Another legal directory
The Virtual Chase (www.virtualchase.com).  A site produced by a legal librarian that
provides tips and resources on conducting legal research online.
LII, Legal Information Institute (www.law.cornell.edu).  Site maintained by Cornell Law
School.
Law.com.  (www.law.com).  Comprehensive site seeking to be a one-stop website for lawyers
sponsored by the American Lawyer Media group (ALM).
Society of Corporate Secretaries & Governance Professionals
(http://www.governanceprofessionals.org).  A very good website for those with corporate
secretary responsibilities.  Much of the information is limited to members only.
RefDesk (refdesk.com).  A general reference desk website with all sorts of search engines and
index links.

The internet is also being used as a collaboration tool or outsourced data network for all sorts
of applications.  Many services and applications are now available and hosted by internet
based companies.  While some have concerns about security and control, others welcome the
freedom from the burden of maintaining equipment and software and being tied to one
physical location.
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Case Study: NDAs
Nondisclosure agreements are good
candidates for technology solutions
–repetitive, standardized, high frequency

Different technology approaches
Templates • document generators • request forms

Self-service approaches

Use of intranet

Each panelist will discuss the approach their department took to handling
NDAs.

We will discuss models involving “push-pull” technology use where clients
request NDAs by completing and submitting a request form and then receive
their completed NDA.  We will also discuss self-service approaches using
templates and instructional material.

ACC's 2006 ANNUAL MEETING THE ROAD TO EFFECTIVE LEADERSHIP

This material is protected by copyright. Copyright © 2006 various authors and the Association of Corporate Counsel (ACC). 7 of 12



ACC’s 2006 Annual Meeting: The Road to Effective Leadership October 23-25, Manchester Grand Hyatt

Personal Productivity

Make effective use of tools you have or can
get for free or nearly free

Use power user features in your word
processor: autotext, macros, templates,
tables, style sheets

 Google desktop to search your own and
network drives

Adobe for more secure forms

ACC members use many different word processing programs.  Almost any modern word processing
program has these features; consult either your help desk or the help feature within your program to learn
how to use them.

Autotext allows you to use abbreviations for frequently used text blocks or entire documents.  For example,
at Gelco there is an autotext entry for a standard addition to an assignment clause which permits
assignments to corporate successors.  The text “assign” plus the F3 key generates the entire clause.
Autotext can be extremely useful for litigators; the standard text for “admit,” “deny,” and “lacks sufficient
information,” responses to complaints can be put into autotext.

Templates are a means of making sure that your master documents are never modified by accident.  You
generate individual contracts from the template, rather than by copying the master document and hoping
you remember to “save as” before you accidentally make changes to the master document.  Templates can
also be set to allow text to be entered only into certain sections.  However, unless some form of document
locking requiring a password for changes is used, be aware that a customer can usually copy the entire text
and paste it to another document for editing.  Templates can also be used when documents are sent to the
field for completion along with training about why they should always use the template rather than their last
contract.

Tables are an efficient way of presenting information and are more flexible than cutting and pasting cells
from a spreadsheet into a document.

Style Sheets  are sets of formatting characteristics applied to text in a document to quickly change its
appearance. Applying a style is applying a group of formats in one simple task.  Styles can be used to help
standardize formatting in contract documents.

Google Desktop is freeware that compiles an index of your hard drive (you can designate specific parts to
be indexed) and of specified network drives.  Once the initial index is complete, Google Desktop runs in the
background to keep the index up to date.  Google Desktop allows you to search your desktop with standard
Google searches; it is generally much faster than the built in Windows search features.

Adobe allows the creation of secure forms; the user opens the form and can only type into the permitted
fields.   Not all versions of Adobe support this feature.
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When Technology Goes Bad
Security
Backups
Disaster recovery
Misuses of redlining
Defeating document protection

Security: The legal department has special security concerns and needs to work closely with
the IT department to make sure that sensitive documents are not at undue risk.  Are shared
legal drives accessible by others within the company?  What about your backups?  If a laptop
from the legal department is stolen, can data be read from its hard drive?  Some laptops include
automatic hard drive encryption.  To prevent access to legal information, some legal
departments save all of their documents to a network drive managed by a corporate IT
department. Access to the shared drive is limited to specific individuals.

Backups:  Who is responsible for backing up legal documents, and how often?  Again, work
closely with your IT department.  If individual users are responsible for backing up their own
computers, consider a department-wide backup regimen and testing to be sure it is happening.
You don’t want to wait until your attorney’s laptop is stolen to discover that the attorney has
not been saving all documents to the network drive as required or making regular backups.

Misuses of Redlining:  Every person in your organization should know how to redline and
how to accept or reject changes.  Some people use the options to just not show changes on the
screen or in the printed document rather than accepting changes.  This can result in
considerable embarrassment (not to mention potential breaches of confidentiality) when the
recipient of the document turns on those options and can see all changes.  There’s nothing
quite like receiving a contract and seeing what your prospective supplier offered to their last
customer because they sent you a document that shows you all the changes.

Metadata:  Metadata is hidden, automatic redlining of changes to virtually every computer
document.  Someone with a metadata reader may be able to see the changes you made to your
document, even if you did make a correct acceptance of changes.  For a discussion of metadata
and MicroSoft Word, see
http://www.metadatarisk.org/document_security/doc_security_overview.htm.  If you do not
use templates or have a very sensitive document situation, consider looking into a metadata
cleaner.

Defeating Document Protection:   Unfortunately, electronic documents are susceptible to
being copied and changed, and there are ways around most standard document protection.  It is
generally possible to take even locked documents and manage to cut and paste their text into a
fresh, editable document.  There are even programs that convert Adobe PDF documents back
into word processing files.  If you have serious concerns about the other party making
undisclosed changes and signing a document, consider sending the document out on raised,
colored letterhead, which requires considerable effort to counterfeit.
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Resources
Law Technology News (www.lawtechnews.com) a free monthly
newsletter regarding products, systems, and services for legal
professionals

ACC Technology InfoPAK (www.acca.com/infopaks/tech.html)

103 Using Information Technology in the Law Department
(http://www.acca.com/resource/v7272)

602 Technology Tools for Small Departments-Beyond Email & Word
(www.acca.com/resource/v5615)

Technology Tools for Small Law Departments
(www.acca.com/resource/v4682)

The Legal Technology Primer (www.acca.com/resource/v956)

ACC SLD Listserv

Document assembly information: http://www.bashasys.com/documentassembly.html and
http://www.bashasys.com/documentassemblysolutions/document-assembly-corporate.html

Additional Materials About Metadata 

In this context, metadata means data embedded in a computer file that is not ordinarily viewable 
as part of the text.  This is information that may show up with the use of a metadata viewer and 
can include the name of the author, the originating company, the name of the network server or 
disk where the document was saved, file properties and summary information, non-visible 
portions of embedded objects, the names of previous document authors, document revisions, 
document versions, template information, hidden text, or comments.    

Both Microsoft Word and WordPerfect generate metadata.   Each publisher provides some 
guidance about what sorts of metadata might be embedded and how to minimize them.1  In 
addition, both Excel and PowerPoint generate metadata, which may be of keen interest to your 
client organizations as no one really wants a prospective customer to see what was presented to 
another customer.   

Metadata offers an unhappy opportunity to make an inadvertent disclosure of confidential 
material.  While the recipient may have an ethical obligation to notify the discloser that the 
disclosure has occurred, they have no ethical mandate to return or destroy the confidential 
materials thus disclosed.    

Both the ABA and the New York State Bar have specifically stated that lawyers have a duty to 
prevent disclosure of metadata with confidential information; the Florida State Bar is considering 
a similar ruling.2    Furthermore, the metadata embedded in documents may result in unexpected 
disclosures during discovery.   

On a practical basis, what does this mean to you?   It might be a good idea to use a metadata 
reader on a sample of your department’s own documents to understand what sorts of metadata 
are embedded.   Check with your IT department to see if your company already has a metadata 
reader or scrubber.   For the low budget initial approach for Microsoft products, there are several 
trial versions of utilities offered for free.3    

                                               
1 Microsoft provides information about metadata in Word at http://support. microsoft.com/?kbid=237361, while Corel provides information about 
metadata in Wordperfect at 
http://www.corel.com/content/pdf/wpo12/Minimizing_Metadata_In_WordPerfect12.pdf#search=%22metadata%20wordperfect%22
2 NY Bar Ethics Opinion 782 http://www.nysba.org/Content/NavigationMenu/Attorney_Resources/Ethics_Opinions/Opinion_782.htm,

Comments 15 and 16 to Rule 1.6 of the ABA Model Rules of Professional Conduct, and Proposed Advisory Opinion 06-2, 

http://www.floridabar.org/TFB/TFBResources.nsf/Attachments/53EDEDC5599019138525719A006DCE1B/$FILE/06-

2%20pao.pdf?OpenElement 

3 http://esqinc.com/index.php?p=downloads offers Idiscover and  http://www.workshare.com/go/metadata-software.aspx offers a trial version of 
its Workshare product.
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From the May 2006 edition of the Oregon State Bar Bulletin 

Managing Your Practice 
Reprinted with permission from the Oregon State Bar and Sheila Blackford: 

Metadata: 
Danger or delight?
By Sheila Blackford 

Although most attorneys and law firm staff have heard of "metadata," most don’t fully 
understand how it can work for you or against you. 

In the proper context, metadata is harmless and extremely helpful for collaborative writing and 
editing work. But if the document you are transmitting to opposing counsel contains comments 
and notations that have been affixed to the document, you may have inadvertently waived the 
attorney-client privilege and work-product doctrines, violated ethics rules about client 
confidentiality and committed malpractice with your computer. 

Not likely to happen to you, right? Consider the following scenario. You send your client a 
finished legal document as a Word e-mail attachment. Your client opens the document and learns 
that the document was drafted by your paralegal by cutting and pasting from a prior client’s 
document and edited by a first-year associate. The client also discovers that the total editing time 
tracked in the document doesn’t match the total hours billed by the billing attorney, whose name 
and billing rate don’t match the names and billing rates of those who actually did the work. 
Document statistics such as the last 10 authors, the amount of time spent editing, and file dates 
can create awkward situations such as this. 

Metadata may cause problems in other areas you hadn’t considered. Much hype has surrounded 
metadata ever since the March 4, 2004, CNET News.com disclosure that SCO Group’s lawsuit 
against defendant DaimlerChrysler for alleged violation of their Unix software agreement was 
initially prepped as a lawsuit against Bank of America for copyright infringement. You may have 
enjoyed the benefit of using a suite of programs like Microsoft Office, especially because it is 
easy to pull data from one program into another, such as copying part of an Excel worksheet into 
a Word document. However, if you do this from the Edit menu using the "Paste Special" feature 
and selecting "Microsoft Excel Worksheet Object," you may be in for a surprise. Double-click on 
the Excel worksheet object in your Word document and you’ll discover that the entire worksheet 
document is visible, including other worksheet tabs that may contain sensitive information. The 
entire Excel worksheet is known as an embedded object and is metadata that travels with the 
Word document. Thus, the full Excel worksheet can be viewed by the receiver of the Word 
document, even though you didn’t intend that result. The detriment of exposing more that a 
select portion of an Excel spreadsheet may be exponential if the additional figures pertain to your 
negotiation strategy on settlement offers or disclose profit projections for complex financing 
plans. 

In complying with discovery requests, you are required to provide only the documents and data 
set out in the discovery demand. Beware — if supplying electronic versions of your documents 

— that you are not providing more information than required by inadvertent disclosures in 
document metadata. 

Metadata has been almost totally linked with the Microsoft Word program. It also exists in 
Microsoft Excel and Microsoft PowerPoint. It chiefly has been cited as a problem with word 
processing documents. Some people erroneously believe that it does not affect Corel 
WordPerfect or Adobe Acrobat PDF documents. There may be less metadata, but it is there, 
nonetheless. Even less commonly used programs such as Lotus Word Pro 9 and the former king 
of spreadsheets, Lotus 1-2-3 (part of the Lotus SmartSuite) contain metadata. Metadata exists in 
many other software programs as well. 

Some metadata is readily accessible and visible to anyone opening your document in the 
application program in which it was created. Other metadata might not be immediately apparent 
when you view the document in your application program but is accessible by opening the 
document in a low-level binary file editor. To check for basic metadata, open a new document, 
select "Properties" from the File menu, and you will see an assortment of metadata that stays 
with the document. 

Metadata That May Be in Your Document 

Some metadata is fairly innocuous, while other metadata is the potential electronic smoking gun. 
Here is a quick list of what may be in your document, depending on which program created the 
document. 

• Authors 
• Comments 
• Company or firm name 
• Computer name 
• Document revisions 
• Document versions 
• Embedded objects or non-visible portions of embedded OLE objects 
• Fast saves 
• File location 
• File properties 
• Headers and footers 
• Hidden text 
• Hyperlinks 
• Initials 
• Linked objects 
• Matching font 
• Network or server name 
• Personalized views 
• Revisions 
• Small font 
• Summary details 
• Styles 
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• Template information 
• Tracked changes 
• Undo/redo history 
• Versions 

Options for Handling Metadata 

No central place addresses all metadata issues in all programs. You can turn off some features 
that create metadata in the "Options" dialog boxes by selecting "Settings" under the Tools menu. 
Other programs have an Options menu and include "Security" settings to address some metadata 
issues. Good places to look are the pull-down menus under File, Edit, View, Insert, Format, 
Table and Tools. Visit the website of the software publisher for possible articles on metadata and 
search for "metadata" or "minimizing program X metadata." Programs include metadata for a 
variety of legitimate purposes to facilitate editing, viewing, filing and retrieving capabilities. You 
will likely just want to turn off the features that create metadata before sharing the document in 
an electronic format. 

One option is to save your document to RTF (Rich Text Format) before attaching it to an e-mail. 
Under the File menu, select "Save As" and, in the dialog box for the File Type, select the option 
of saving your document in RTF Rich Text Format. Documents in this format will show ".rtf" at 
the end of the file name. 

Another option is to print your word processing document and then scan it and turn it into a 
Portable Document File or PDF format using scanning software such as ScanSoft PaperPort. You 
then select the document, which now will have a ".pdf" file name extension, before sending it as 
an e-mail attachment. Right-click on the PDF document and select the "Send To" option and 
"Mail Recipient." This automatically opens your e-mail program and attaches the PDF document 
to the blank e-mail. You are sending an image PDF document, which cannot be edited by the 
recipient (unlike text PDF), and which will contain some metadata, such as the date the PDF 
document was created. But any metadata that existed in the document prior to converting to PDF 
format will not be transferred to the PDF document. 

WordPerfect 12 users are likely smiling that they can turn their WordPerfect document into a 
PDF document under the File menu by selecting the "Publish to" option and then selecting 
"PDF." You might want to be cautious about the properties of the PDF you are creating. Check 
the tabs in the "Publish to PDF" window, such as the General tab where you can remove the 
author name that automatically fills in from the converted WordPerfect document. Under the 
Document tab, you may deselect "include hyperlinks" and deselect "generate bookmarks" if 
these are metadata that you do not wish to share. 

Metadata Cleaners 

You may decide to invest in a metadata cleaning program. At the Microsoft Web site, you can 
find a lot of information about metadata and download a free utility to scrub the metadata from 
your documents. The Office 2003/XP add-in "Remove Hidden Data" allows you to permanently 
remove hidden data and collaboration data, such as track changes and comments from Microsoft 

Word, Excel and PowerPoint files. Microsoft cautions that "Remove Hidden Data" has not been 
tested on Microsoft Windows 2000 and that it cannot be installed on Windows 98 or the 
Windows Millennium Edition. This is another reason to update your Microsoft operating system 
and to install Microsoft Service Packs and Security Patches as they become available. 
(www.microsoft.com/downloads/) Programs such as Metadata Assistant for Word, Excel, and 
PowerPoint are available from the Payne Consulting Group website. 
(www.payneconsulting.com/products/ProductDetail.asp?nProductID=34) The website promotes 
it as the most popular metadata cleaner on the market, with over a million users worldwide. 
Another choice is the BEC LegalBar Metadata Scrubber available from the BEC (Business 
Equipment Company) Legal Systems website. 
(www.beclegal.com/lsy/lsylegspeclegbarmetadata.asp) Appligent’s utility family includes 
software components such as "APSetDocInfo" that enable you to modify the metadata of a PDF 
document. See their PDF utilities at www.appligent.com/ products. The principle behind these 
metadata cleansing programs is to give the software user the ability to identify and either modify 
or remove metadata. Since metadata becomes an issue with sending electronic versions, you 
should be sure that the metadata cleansing program works with your e-mail program, whether 
it’s Microsoft Outlook, Eudora or Lotus Notes. 

Ethical Considerations 

Should an attorney be able to view metadata contained in opposing counsel’s electronic 
document? Should metadata be discoverable? If the metadata is not readily apparent, is it ethical 
to use a program such as Princeton Software’s "Meta Data Reviewer," which allows the user to 
search, explore and export 41 fields of information about each file (and which can be purchased 
for $19.95 at www.princetonsoftwarecompany.com.)? Interestingly, Appligent sells a program 
"APGetInfo" that enables the user to get metadata from PDF files for $149 which includes the 
ability to retrieve XML metadata from PDF documents that support the Adobe Extensible 
Metadata Platform (XMP). This program is also located in the Utilities at the Appligent Web 
site. 

Computer forensics experts and electronic discovery service providers may provide the expertise 
if you are on the offensive. But if you are representing the defense, you would be prudent to 
consider the full ramifications before stripping or scrubbing metadata from discovery documents. 
It might be viewed as spoliation and could result in an ethics violation. You may need to get a 
protective order that permits the scrubbing of metadata from documents that are subject to 
discovery. In fact, some discovery requests now include metadata along with requests for the 
documents, treating it the same as postmarked envelopes and fingerprint dusted documents. 
Increasingly, courts are addressing the issues around metadata and electronic discovery and rules 
are being adopted in various jurisdictions. For example, New York has published Opinion 79-
12/14/01:DR 1-102(A)(4), DR 1-102(A)(5), DR 4-101, DR 7-102(A)(8), Canon 4, Canon 7, EC 
4-1, advising that "Lawyers may not ethically use available technology to surreptitiously 
examine and trace email and other electronic documents." Attorneys in Oregon have treated the 
concept of metadata as an inadvertently sent document and thus view the guidance of ethical 
conduct by the Oregon Rule of Professional Conduct Rule 4.4 Respect For the Rights of Third 
Persons; Inadvertently Sent Documents (a) In representing a client, a lawyer shall not use means 
that have no substantial purpose other than to embarrass, delay, harass or burden a third person, 
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or knowingly use methods of obtaining evidence that violate the legal rights of such a person. (b) 
A lawyer who receives a document relating to the representation of the lawyer’s client and 
knows or reasonably should know that the document was inadvertently sent shall promptly notify 
the sender. 

You don’t need to stay awake at night worrying about metadata. Just become more mindful when 
you are sharing or delivering documents electronically. The savvy way to practice is the safe way 
to practice. 
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